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Activation
Upon starting FOCUS projects 4 for the first time, you will be prompted to activate the
program. Proceed as follows:
Install FOCUS projects 4 as described by the installation instructions.
Input your serial number. For the box version, this can be found on the accompanying
booklet. If you have chosen to download the program, you will have received the
serial number by email directly following your purchase.

Finally, click on the “Activate” button. The software has now been successfully
activated!
Note: FOCUS projects 4 can be installed on up to two computers using the same
serial number.
A second serial number is not necessary. When installing the program on a second
device, simply enter the serial number again and press “Activate”.
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1. Fascinating Macro Photography
The world of macro photography is often considered one of the most awe-inspiring
fields of photography. Macro photos don’t only provide for a visually inspiring image
experience but also help bring hardly noticeable or even completely unseen
photographic details to life. Magnification of ice crystals on a window or the delicate
wings of a dragonfly reveal nature’s miniature works of art and provide access to a
completely new photographic world of possibility. If you’re new to this line of work,
begin with easier image edits. Grains of salt, screws, model cars or even feathers are
all fantastic macro photo objects worth displaying in full detail.
I have a macro lens. Why do I need FOCUS projects 4?
You’ve undoubtedly come across the situation before. Zoom in on an object too close
and a focus depth at aperture 32 still isn’t large enough to display the entire object in
full clarity. Small aperture sizes often leave brightness levels too low and diffraction
clarity issues tend to arise resulting in reduced detail sharpness.
Here, the focus Stacking Method can help: This technical term describes the process
of combining images with varying sharpness levels within a single image. The
resulting image computed in FOCUS projects 4 pieces together all infocus
regions of each individual image onto one layer, thus displaying the entire
image in absolute clarity.
15 photos have been taken for use in the following matchbox example.
Displayed here are
the first and last
shots from an
image series. In
total, 13 additional
photos taken
between the first
and last image
were needed to
display all of the
matches in full
focus.
FRANZIS Verlag GmbH
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FOCUS projects 4 layers and precisely aligns all images and computes a
single image from the data. All relevant areas of the resulting image then receive the
necessary degree of focus.
Tips for your first macro shots:
Retro-Adapter
There’s absolutely no need to buy a new lens – just rotate your standard or
wideangle lens. There is a wide range of priceworthy adapters available on the
market.
Using ISO
Make proper use of your camera’s wide range of ISO capabilities. ISO up to 2000 is no
problem for most new cameras.
Use a Tripod
It is almost impossible to hold the camera completely still in telephoto position. Here
you should use a quality tripod and a remote release for your camera. Using a remote
release for your camera ensures that your camera remains absolutely motionless
during shutter release. Alternatively, you can also lean your camera against a stable
surface.
More Light
If you wish to use shorter shutter speed and a greater depth of field, just add more
light. For this, you can use LED ring lights or a macro flash.
Which aperture is the best?
This question has no simple answer: This depends on the lens you’re using. Select the
aperture which yields the best image performance when used together with your
preferred lens. This is usually found somewhere between aperture 5, 6 and 11.
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Insect Macro Photography
If you would like to compile Focus Stacks of insects, getting out early in the day is key.
Shots taken around midday don’t often yield positive results. Photographing around
dawn when insects are sleeping or still in hibernation offer the best chances for
success.
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2. What´s new in Version #4?
FOCUS projects 4 offers many new features. Here is an overview of some of the most
important developments:

 Maximum Focus Stack Count: Upload up to 30 images
 Focus Boost Technology: Focus Squared, Focus Cubed, Focus Infinity and
Diamond Cut Sharpening
 Two new Focus Stacking Algorithms: Pyramid Distance und Pyramid Colour
 Significance check for Focus Stacks: According to weighting or according to
image content
 Compression of the Depth Map: More accurate adaptation of 3Dreconstruction
 Acceleration of Focus Stacking Fusion : Focus Stacking Fusion is more than
30% faster

 19 new post-processing effects:
-

Masking - Details

-

Denoising – Banding

-

Denoising – Farbwolken

-

Reduce haze and fog

-

Weighted black/ white point

-

Brightness progression

-

Normalisation

-

Restore hightlights

-

Veiling glare
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-

White and black correction

-

Colour balance

-

Colour dynamic

-

Color gradient

-

Colour light and shadow

-

Normalisation (RGB)

-

Smooth colour tone

-

Gauss soft Focus

-

Neon Glow

-

Warp

 Selektive Drawing:
-

9 Effects

-

4 Composing Levels

-

48 Processing Methods

 Print Final Image (Ctrl + D)

 Clipboard (Ctrl + C)

 Colour normalisation and brilliance optimisation of input images

 Scaling function for input images

 Focus Fusion Profiles
FRANZIS Verlag GmbH

8

FOCUS projects 4 – user manual

 New Effects Category: Smart Mask Filters
There is a new effects category for intelligent and automatic masking of Postprocessing effects which include 8 different masks.
Details
Colour saturation
Colour tone
Gradation
Brightness
Light
Shade
Black – White point

 With the two new preset categories, there are now 62 presets in total:
- Landscape: 6 Presets
-

Glow: 5 Presets

 Interactive Contrast Optimisation in the Focus Fusion

 Reverse the Order of the Image Sequence

 Note Function in the Undo-Timeline
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3. Configuring the User Interface
Optional font size for Menus and titles
In the main menu of the program you will find in View -> font size an option to
customise the size of the letters in the menu as well as in the titles of the programm.

The font size can be adjusted to the run time of the program.
4K-monitors gives you the option to enlarge the font size for better readability of the
menu.

FRANZIS Verlag GmbH

10

FOCUS projects 4 – user manual

4. Macro Photos Done Quickly
You can obtain a finished HDR image in just 5 clicks with FOCUS projects 4:
1. Load Stacking Sequence
2. Post-Processing  Preset Selection
3. Optimisation Assistant
4. Select Image segment and Save, that´s it!

You can simply drag and drop your image sequences onto the start screen.
How to get the results you want, and fast - the elaborated presets and looks,
individual image adaption and selected drawing allows you to go down your own
creative route. FOCUS projects 4 offers both options.
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At the top of the screen are the main menu as well as the menu bar. This menu bar
contains the following functions (from left to right):

-

Image Sequence Browser

-

History Viewer

-

Import Image Sequence

-

Open Project

-

Load Sample 1

-

Load Sample 2

Optionally image data can also simply be „dropped“ onto the screen by Drag & Drop.
Then the image data is uploaded automatically.

FRANZIS Verlag GmbH
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5. Importing Image Material
To load an image simply drag and drop the images onto the start screen.
Alternatively, you can also use the toolbar buttons or drop-down file menu.
The maximum number of possible images is 30 pictures in FOCUS projects 4.
Note: The Image Preparation dialogue is automatically deactivated in the default
settings and is only displayed once the „Always show this window“ option has been
activated in the menu.
The image preparation dialog will open as soon as an image or image sequence has
been selected or draggend and dropped into the program.
Here you can also choose each time you upload a sequence (click on the box at the
bottom).
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 Image Sequence Browser
For a better overview of your image sequences you can use the image
sequence browser before uploading your image sequences.
Click on the corresponding symbol in the task bar. A preview window will
open. Choose by „quell folder” your image sequence folder.

FOCUS projects 4 starts immediately with the calculation, fitting automatically
the right images together as well as showing a preview image. If you go across
the image with the mouse, the image will automatically enlarge itself.
FRANZIS Verlag GmbH

14

FOCUS projects 4 – user manual

The file type-filter is practical here, since one often has jpg rows and RAW
images together in one folder. But if you type in RAW in the file type, only the
RAW rows will be shown. You won´t have any doubles any more.
At 100% the search for images is finished.
From this point on you will be able to upload the desired image sequence Click on the
desired row with a right mouse click and chose in the context menu “open as
project”.

FOCUS projects 4 uploads the images of the desired sequence and just like the simple
Drag & Drop of the images on the desktop we start now with the image preparation.

FRANZIS Verlag GmbH
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6. Menu Bar
7.1 File

File → Start
When you are finished editing an image or
would like to close your current image, clicking
on Start (or Ctrl + N) will close the image
currently open.

File → Import Image Sequence
In order to open an image, click on Import
image sequence (or Ctrl + Shift + O) … to
search for the sequence you would like to edit.

File → Image Sequence Browser
Select your sequence folder from within the “Source-Folder”. FOCUS projects 4
immediately begins its calculation process and automatically gathers the best photos
from your sequence. From here you can then upload your preferred image sequence.

File → History Viewer
Clicking here will provide you with an overview of your separate projects and allow
you to choose between them.

File → Save Final Image
If you are content with your editing results and would like to save your image, click
on Save Final Image (or Ctrl + S) …

File → Open Final Image In External Program
If you would like to continue editing your current image in another program, you
don’t even need to leave FOCUS projects 4 For this, simply click on Open Final Image
in External Program.
FRANZIS Verlag GmbH
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File → Export Image Sequence
Select Export image sequence in order to save your edited exposure bracket and
open it in an external program.

File  Create Exposure Bracketing
Möchten Sie aus Ihrem aktuellen Bild eine Belichtungsreihe erzeugen, klicken Sie hier.
Sie haben die Wahl zwischen drei, fünf oder neun Belichtungen.

File → Print Final Image
Click here to print your final image. The image is automatically and correctly scaled to
the print medium.

File → Final Image Into Clipboard
The final image is posted to the clipboard. You can then seamlessly insert it into other
programs.

File → Projects
If you’ve already begun a project in FOCUS projects 4 and would like to continue
editing, open the file by clicking on Projects.

File → Exit
Click on Exit (or Ctrl + F4) to close FOCUS projects 4 .

FRANZIS Verlag GmbH

17

FOCUS projects 4 – user manual

7.2 Editing
Edit → Edit Image Sequence
FOCUS projects 4 utilizes a complex process to filter
out all accurately exposed pixels and combine them
into one image (please see 14. Macro Image Stacking
and Editing Image Sequence).

Edit → Edit Weightings
The Weight Painter is a tool used for manually editing individual images in a series in
order to selectively alter specific regions of the photograph. (Please see 12. Edit
Weighting with HDR Painter).

Edit → Post-Processing
Once you have edited or removed noise from an image, you find yourself in PostProcessing Mode.

7.3 View
View → Information Windows
This window displays all image sequence
information regarding the preset settings.

View → EXIF Information Window
This window shows you (if available) all image
file EXIF information such as location, camera
type, exposure duration and capture time.
View → Histogram
The histogram provides you with a consolidated overview of the Light Distribution
Information present within your photo. This makes it easy to recognize if your photo
is over/ underexposed.

FRANZIS Verlag GmbH

18

FOCUS projects 4 – user manual

View → Full Screen View On/Off
If you ever feel distracted by the task bar, you can toggle between a normal and full
screen view by clicking on Full Screen View On/Off.

View → Interface-Style… (dark gray)
Clicking on Interface Style... will allow you to alter the color scheme for FOCUS
projects 4. The color scheme you have currently selected will appear in brackets.

View → Font Size
Change the font size levels between small, medium and large.
View → Frame Color: Gray Cart → automatic
If you click on Frame Color: Gray Cart, the program will set the your image’s average
color value as the frame color.

View → Restore Window defaults
Returns the current window to its original size.

7.4 Extras
Extras → Preparing Image
Here you can begin to prepare your images
prior to Macro stacking (see 8.Image
Preparation).

Extras → Settings (Ctrl + P)
Here you will find the various configuration
options adaptable to your unique preferences
offered in FOCUS projects 4.

Extras → Reset
This returns the current user interface to its original size.
FRANZIS Verlag GmbH
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Extras → Create Restore Point (Shift + Z)
If you would like to save your image in its current state and continue editing without
initiating a file-save, simply select the option Create Restore Point or (Shift + Z). This
allows you to return to the last saved state of your image at any time.

Extras → Timeline (Ctrl + T)
Click on the Timeline or (Ctrl + T) to display all saved Undo-Points.

7.5 Add-ons

With the help of Add-ons, you can now not only import Presets into FOCUS projects 4
but also integrate new Post Processing Modules that provide your Presets with an
entirely new look. However, currently are no Add-ons available.
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7.6 Information

Information → FOCUS projects – Homepage
Click here to navigate to the FOCUS projects 4 homepage.

Information → Show Shortcuts
Here you will find all keyboard shortcuts available in FOCUS projects 4.

Information → Supported RAW Formats
A list of all cameras whose RAW Files are able to be opened in FOCUS projects 4.

Information → Check For Updates
This checks online whether newer versions of the software are available for
download.

Information → About FOCUS projects (Shift + F1)
Information about the current version, 3rd-Party Software and Credits from FOCUS
projects 4 .
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7. Image Preparation
Here you can precisely configure the program’s settings.
For the first steps, please use the standard settings. These default set-tings can be
restored with the arrow at the bottom left. Nothing can be irretrievably adjusted.

a. Scaling: Set the scaling for your input image data here. The new image size is
calculated based on the image area. As size of the scaled image data in relation
to the original image data you can choose for example 25% to scale the image
data to half the width and half the height. Choose 50% to scale the image data
to half the number of megapixels. 400% scales the image data to double the
width and double the height.
Moreover you can select a suitable method for interpolating your image data.
The “simple” method is very fast and leads to a direct pixel scaling, while the
“frequency response curve” method takes more time but leads to sharper
results.
FRANZIS Verlag GmbH
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b. Colour space conversion: advanced users
can choose a colour space here - for all
other users, it is recommended to not make
any adjustments, to avoid incorrect colour
rendering later. FOCUS projects 4 offers
several new colour spaces (D65). The
standard illuminant D65 is representative
for a phase of natural daylight with the
colour temperature of 6500° Kelvin.

c. White balance corrects colour casts that
occur with shots taken, for example, in a
warmly lit room. To start, leave this setting
unchanged.

d. With this regulator one can adjust the colour temperature when you´re
already uploading. It is advised that you leave the setting on “default” and to
regulate the colour temperature later in post-processing.

e. Under Optimisations there are three different options for improving your
image data. Normalising the colour ensures that the shadows in the image are
black and the lights in the image are white. You can activate or deactivate the
automatic luminocity optimiser when loading RAW image files. If automatic
rotation is activated, images will be automatically rotated according to their
Exif orientation.
f. Noise suppression: these buttons allow you to select the precision of the noise
removal, and the slider regulates the degree of the sharpness for the edges.
Here dark images can undergo significant noise removal and have hot pixels
(light spots caused by the camera’s sensor in dark situations) eliminated.

g. Exposure: Optimising dark areas of an image can help to reduce the tinging
which frequently occurs in shadows or dark patches. Optimising lights fleshes
out as many details as possible from the light areas of the source image.

FRANZIS Verlag GmbH
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h. Alignment: here you can influence how the individual images of the series are
congruently positioned on top of one another. The subtlest movement of an
object, unintentional zooming or rotating of the camera can be considered. In
the majority of cases, the default settings often lead to the preferred result.
The automatic cropping function corrects empty areas at the edges of your
images.

FRANZIS Verlag GmbH
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8. Post-Processing: Presets

Just like in the last version we shall start after
the uploading of images directly in postprocessing. Here we control the tone mapping
of the images, before editing the results with
filters and effects.
Left side of the post-processing screen: The
presets show the breakdown of the live
preview in categories – „All“, „Natural“,
„Landscape“, „Monochrome“, „Colors“, „3-D“,
„Custom“ und „Glow“ with the quantity of
presets in the appropriate category.
To begin, we’ve chosen the “Natural Neutral”
preset. Clicking on the preview image applies
the effect to the image in real time, which will
then be displayed in the middle of the screen.
Discover the wide variety of different looks by
clicking on the 32 different presets. You will be
amazed by the intriguing styles in the artistic
section!

FRANZIS Verlag GmbH
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Image with „Natural Neutral“.

Image after applying the „Colors Intense“ preset.
All 32 FOCUS projects 4 presets at a single glance. The bar “presettings” you can
detach easily and adjust to the desired size.

FRANZIS Verlag GmbH
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Preview Gallery
Would you like to see all the previews for the loaded image or series? Open up the
category “all” and then subsequently click on the symbol.
FOCUS projects 4 constructs then a browser gallery with all the presets. For a larger
display click on the picture.

This very practical feature is reminiscent of good old contact sheets. You can create
proofs to assess how the image with your favourite presets would look when printed.

FRANZIS Verlag GmbH
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 The variation browser
The variation browser allows you to choose from different versions of a function
and is primarily operated with the mouse:
 Shifting the segment: hold down the left mouse button, before moving the
mouse
 Zooming in: scroll up
 Zooming out: scroll down
 Choosing the variant: double left click on the image
 Setting a referent: left click on the image
 Comparison with referent: hold down the right mouse button over the
image
The corresponding short cuts you can find under “menu”  “information  short
cuts”.

Click on the symbol and FOCUS projects 4 will show you the entire preview gallery
of that chosen category. Zoom in now on the variant that you want to compare
and set a reference image.
This reference image you will be able to put on any image through a left click of
the mouse. You can fade in this reference image into the other image by holding
down the right mouse button. The border surrounding the image in a green
dashed line shows you the reference image so that you can make the comparison.
In this way you can compare any two variants in the browser directly and visually.
FRANZIS Verlag GmbH
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Example: As a reference image you choose the variant
“Natural Soft Contrast” and mark the image with a left
mouse click. The green dashed line shows that you have
chosen this image.

Now you look for a different preview image, in this case Preset „Colors Intense “ has
been chosen.

Right click on the preset „Colors Intense” and the reference preset will fade in. As
soon as you let go of the mouse button, you will see the „Colors Intense” again. This
is how you simply and purposefully compare looks with another before choosing the
ones you like the best.
Selection of your desired variation:
With a double click you chose the variant. The relevant program settings will be
carried out automatically.
Deleting of a variation:
If you want to delete a variation, move the cursor over it and click the [Del] button.
After that, click on the “compress” button. If you want to display the deleted
variations again click on “reset”.

Tip:
Your current choice will, when you open the window, be automatically set as your
reference image.

FRANZIS Verlag GmbH
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 Combine Presets
To merge two looks together use the “Combine default presets" button directly
under the categories. These new presets will be saved under "Custom". It’s that easy
to expand your numerous options and accumulate new ideas!

 Name Favourites
Have you found certain presets that you love and
instantly want to have handy? Click on the top right
star in the preset window and add the setting to your
favourites. By clicking the button, previews all of your
favourite presets will be displayed.

 Save Undo-Point
With the Save Undo-Point Function you can save your edits to an image at
different intervals and later view these in the Timeline and pick up where you left
off.

 Timeline
In the Timeline you can view and directly access all saved Undo-Points.

 Image Sequence View
The image sequence player is a tool that lets you analyse Focus stacks. Here you
can look at the whole sequence as a film in order to spot gaps in the sharpness
depth layers. In addition, you can use it to add the weightings of your selected
focus stacking algorithms to the video sequence (by using the slider in the upper
bar). This enables you to recognise if single areas will yield better stacking results
after retouching.

FRANZIS Verlag GmbH
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 Comparison View

Do you want a comparison to the macro image? Simply right click on the middle of
the image to see the before/after result.
A quick check on the editing process is available at any time. For an extensive
overview with selectable areas and luminance display, click on the symbol bar.

FRANZIS Verlag GmbH
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 Preview Mode
Is this option is activated your original image is displayed in a smaller version. If you
switch it off, all calculations will be carried out in full-size images. Please note that
deactivation takes more time to process in the preview mode.

 Real Time Processing
When activated, all of the changes that you have made to the preset settings will be
immediately applied to the image and you will see the outcome of your adjustments
directly. If this option is deactivated, then you will only see the outcome of your
adjustments when you click the button “calculate afresh”:

 High-Quality Display
Activate this option to see the preview image in high-resolution. If the preview is set
at 100%, there will be no difference. If you zoom in on a section of the photo
however, there is a noticeable difference in quality.
 Border Pixel Display
The border pixel display helps to reveal areas that tend towards maximal light and
dark values that is to white and black. Dark border pixels are depicted by blue and
light pixels by orange.

FRANZIS Verlag GmbH
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Depiction of border pixels in dark blue and orange tones.
If you would want to brighten this image, you have to be careful of the orange border
pixels. Light surfaces on the car and the walls should not become too white, in order
to avoid losing detail. In technical terms, these patches are called “burned highlights”.
The border pixel view helps to find these critical image areas
 Symbol „Original Resolution Setting“
With this pushbutton you will set the zoom factor on the original resolution.
 „Increase the Zoom factor to the screen size“
With this symbol you will enlarge the zoom factor to the maximum possible screen
size.

 Import/Export of Presets

Presets from earlier versions can be easily imported. Do you want to exchange all of
your presets with a friend or just secure all of your treasures? Use the practical
export function.

FRANZIS Verlag GmbH
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 Filter Presets
Locating presets can be difficult when you have
imported presets or created many additional looks.
For example, enter “filter" into the search bar and
only presets relating to “focus” will be shown, for
example “Natural Maximum focus”and
“Monochrome Maximum focus”. This makes the
search a lot easier.

 Custom Presets
One thing is certain, regardless of which settings you have changed, if you have
applied additional filters or adjusted a filter’s settings, the selected preset has been
modified and to the right of the preview image is the following symbol:
Clicking
will reset the preset back to its initial
state. Careful: All of the modifi-cations applied up
to this point will be undone!
Clicking
preset.

saves all of the changes in a new

A dialog box will open where you can enter a new
name for your preset or confirm the suggested
one. The system will name it “Copy”.

FRANZIS Verlag GmbH
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The preset will be saved and moved to the
“Custom" presets category. The new preset has
been additionally generated and the starting
preset is preserved. You can also never overwrite
a default preset!
Let’s switch now to the “Custom" preset
category.
Here we can find our first custom preset.
There are a few new symbols to the right of the
preview image:
Is this the favourite preset that you have
made? Mark it to find it right away next time!
Have you changed this preset and don’t want
to lose this new look? Then create a new one!

Reset the most recently changed settings for
the newest preset.

You have readjusted once again? No problem.
Save the changes with the disk symbol.
Change the preset’s name
You can also delete your custom preset
entirely.

FRANZIS Verlag GmbH
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Use this to enter a search filter. For example, enter the search filter „Color play“,
and subsequently type the term into the search filter bar directly under “Import". All
presets with this search filter will be dis-played.
You can enter the names of places you’ve holidayed and all of the presets that you
used for those specific holiday photos will then be easy to find and to apply to other
pictures.
The filter drop down menu to the right already contains „Color play“ and you can
simply select it from the entered search filters.

FRANZIS Verlag GmbH
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9. Post-Processing: Finalisation
Now that we have understood the most important part of post-processing, let’s go
onto fine-tuning, which can be found on the right
side of the screen under “Finalise". These features
are intended to only to be used to edit pictures
further after selecting a preset.

 The Magnifying Glass
On the right hand side (at the very top) in Post-processing you will find the 1:1
magnifying glass. The magnifying glass shows you the area under the mouse in a 1:1
pixel view.

When clicking on the magnifying glass the new compare window will appear, which
compares your edited image and the original image. It simultaneously gives you the
opportunity to examine the comparison through the magnifier display.

FRANZIS Verlag GmbH
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To keep the magnifying glass on a specific point, press down on the “L“ key, while you
move the mouse over the screen.

Click into the image area of the magnifying glass, to change between the display
modus “divided before/after comparison” and “direct before/after comparison”.
To free the fixated area of the magnifying glass, press down on the “L” key once
more.

 Point of Interest
Activated “Point of Interest” renders the current editing only to a specially defined
area of the image. The effects will be applied in their full form, however only visible in
the specified spots, the rest of the image will be left unaffected. This effect is
intended for very large, high-resolution photos, for example panorama pictures.
FRANZIS Verlag GmbH
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 Intelligent Colour Space (SCA Method)
This menu offers you options for optimal colour
detail gradation of your tone mapping results.
Selecting SCA method (Smart Colourspace
Adaptation) demonstrates differences in the details of more saturated colours.
Tip: With “Supersampling” you will get exceptional details and saturated colours and
stark color variations around contrast edges.

 Optimisation Assistent
The optimisation assistant is a very efficient tool for
fast, fascinating results.
When the preset is activated, denoising, tonal value,
clarity, dynamic and sharpness settings can all be
adjusted by sliding the control to the left or right. The
result can be seen live.
The optimisation assistant is intelligent; it remembers
the values you entered, and applies the same settings
to the next image in the same way, but tuning the
result to the new motif.
If you would like to edit without the assistant, you
can simply turn it off. If you would like to turn off the
values that have been “learned” so far, click on the
button.
Additionally, the assistant can be given optimising
specifications for an entire image style: choose
between „naturally cool“, „naturally warm“, „soft“,
„fine“ „brillant“, „intense“, „muted colors“,
„Multicolor“, „High-Key“ , „Low-Key“ und „Low-Key
Multicolor“.
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 The Opacity Regulator of the Optimisation
Assistant
The opacity regulator in the optimisation assistant
activates itself automatically as soon as one
optimisation is activated. The opacity regulator
works on every effect that optimises the image as
well as the optimising presettings.
 Colour Toning:
Use colour toning to give your image a special
colour mood. Select a toning variant and
control it´s special effect using the slider for the
colour tone, saturation and opacity.

 Granulation Module

a) Natural Grain
In natural grain the different levels of photographic
paper are simulated, which creates a natural
irregularity.
These following parameters are therefore at your
disposal:
-

Form: Choose here from six different variants

- ISO-Number
The preset value conforms to the average “restless value” on a naturally grey surface
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- Size
The maximum size of the simulated granulation
- Masking
Gives you the opportunity to calculate the granulation in all different types of
daylight or alternatively in light, shade or shade and light

Complete: all brightness values receive natural film grain.
Lights: the lights receive natural film grain.
Shadow: the shadows receive natural film grain.
Lights & Shadows: Both receive natural film grain.
A Click on the button creates a new random distribution of grain and
therefore a whole new look.
b) Fractal Grain

Fractal grain simulates a large scale irregularity, which is created through the storing
and deterioration of photo material.
Therefore the following parameters are at your disposal:
-

ISO-Number

The preset value conforms to the average “restless value” of a naturally grey surface.

-

Quality
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Determines the accuracy of the calculation (number of iterations for the fractal
algorithm) of the fractal granulation
In the granulation module there is no singular best setting, since the ideal grain size,
form and quality is 100% dependant on the motif. Here you can try out different
things and find new creative paths.
A Click on the button creates a new random distribution of grain and
therefore a whole new look.

Information and helpful tips on making local adjustments and using Selective Painting
can be found in Chapter 15. Local Adjustments/Selective Painting.
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10.

Expert Mode

You can edit effects in different areas of the interface.
Underneath the focus stacking method is the
finalisation assistant. The assistant shows you all
active features in the panel finalisation in a neatly
arranged way. Additionally you can deactivate the fast
access functions here. Underneath that is a list of all
the available post-processing filters. Double-clicking
on one of them will add it to the end of the list of
effects, you have selected.
If you want to change the values of a single effect
within the list, select the effect by left-clicking on it.
You can now see an area with all the parameters for
the effect you have chosen below the list of selected
effects.
Here you can choose the settings for the processing
method with the corresponding opacity, effect
intensity, colours, positions and many more. Please
also note that you have a context menu available
within the list of selected effects.
In order to get the hang of these values you can
either take a look at the tooltips, or just click on some
default settings and see how the effects and their
respective parameters change.
Smart Mask Filters: FOCUS projects 4 computes the
chosen effects from top to bottom. This means that
the order in which you´ve added effects within your
list can have a major influence on your image result.
For example, it the effect “Masking luminance” is
activated, effects applied thereafter will only influence the brightness levels within
your image.
Beneath the display for effects, you have selected, is furthermore the “copy result
image to original image” function. It sets the current result image as the new original
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image as if you had uploaded the result image directly. Use this function to save
computing time when using a very large number of
effects.

Another effective option for setting up parameters is
the real-time preview.
To the left of every slider in the parameter area you
can find a “play” button. Clicking on it will make the
respective slider go in one direction and then in the
other. If you have found your desired setting this way,
simply press “Esc” on your keyboard to apply this
value to your image.
Each filter enables the user to determine the layer
effect and opacity level for the chosen effect layer.
Opens the Selective Editing view for the effect currently selected.
Copies the selective areas to the clipboard.
Adds the selective areas from the clipboard to the currently selected effect.
Displays the selection of preset selective processes.
Deletes all selective areas of a selected effect.
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11.

Edit Weighting

The Painter is a powerful tool to manually adjust a macro image by editing individual
images of a sequence to selectively change certain areas.

Image Sequence View (left): The individual images of a series are sorted into red,
green and blue. When the bracketing has more than 3 exposures, the master image
will be set as green and the next active neighbouring images as red and blue. If you
would now like to make changes to the weighting of a particular image, pay attention
to the image’s colour and choose the respective colour in the paint symbol bar.

To clarify: To paint with the brush does not mean, that you paint colours onto the
image, but you transfer the sharp areas of an image onto the final image.
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Example: The stack of a dice consits of three images that were assigned to the
colours red, green and blue. These colours indicate which image area has been
created from which image stacks. In order to manually change the weighting for a
certain area - for example for the blue (third) image – which means that only the
background image will be used during the calculation of the focus fusion, select the
blue colour from the retouching toolbar, the “increase
weithting” tool and the stance (in order to decrease
the weighting of all the other images).
Adjusted Weighting:

After drawing, the adjusted weighting can be seen
to the right of the individual image. The white
areas mean that these parts are more weighted
now.
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 Important Tools of the Painter:
Increase weighting: Draw on the selected area to enhance
the weighting of this portion of the image
Reduce weighting: Draw on the selected area to reduce
the weighting of this portion of the image.
Brush size: Adjust the size of the brush.
Brush form: With numerous new brushes, you will find the
right from for your selected area.
Stamp: The stamping mode not only edits the weighting of
the current image, but adjusts the weighting of all of the
other exposures accordingly. For example, if you use the
paint tool to increase the weighting of an area in one
image, the weighting of that same section will be reduced
in all of the other exposures to amplify the effect.
Blurring: If you want soft transitions between corrected
and original areas, trace the blurring function over the
borders to soften the transitions.
HDR-image/ weighting: This function mixes the view between the HDR image and the weighting. This is very
effective for maintaining control while drawing.
Delete weighting: Delete the drawn weighting for the
active image of the series.
Delete all: Warning: This function deletes all of the drawn
weightings and returns to the initial settings.
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12.

Presentation Functions

In the presentation functions area are two blocks available.

 Web Presentations
Here you can create 3D animations of your
focus stack. These can be saved either as a
website or as a video file. To configure the type
of animation, select “Configure animation” –
this will open the settings area of the animation
creation tool.
With the box underneath you can adjust the
number as well as the width of your images (in
pixels).
In addition, a range of options are available to
you that let you animate the camera, light
sources and the focal distance. You can choose
between six different types created objects.
The symbols of 3D glasses activate the 3D view
with the help of a red-cyan, red-blue or redgreen anaglyph glasses.
The JPG quality determines the quality of image compression within the web
presentation. The higher this value the better the quality of the result and the file
size.
Save Web Presentation creates a web presentation in a self-contained HTML site.
Save Video creates a QuickTime (Vjpeg) video of your current animation parameter
settings.

 VRML export
If you want to further edit your focus stack as a 3D object, you can do so with the
export function into the standardised VRML format. After export, the 3D object will
automatically open in your installed VRML viewer.
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You can adjust type, scale as well as detail level for the VRML export. The quality
determines how many triangles will create your 3D object. A low value will create an
object with around 5,000 triangles, while a high value will create up to a million
triangles.
The edge protection of the 3D VRML export ensures that the 0 level is kept within the
edges of your image.
If you don’t have a VRML viewer on your computer, you can find a very good
software solution at: http://www.instantreality.org/
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13.

Macro Image Stacking and Editing Image Sequence

Editing the focus stack is optional. In order to go to this area, select „edit image
sequence”

13.1

in the upper toolbar.

Significance Check

The Significance Check can be used to identify and remove images which do not have
a major editing effect on the image result. Here you have two different check types at
your disposal: Weighting and Image Content. The first method is quicker since this
checks the image weightings which have already been calculated. The latter method
incorporates pixel sharpness of individual pixels resulting in a far more accurate
result.

The removal of images without a significant part in the processed image reduces the
size of the image sequence to those images that contain a relevant part of the image
fusion result.

13.2

Reverse Sequence

This function reverses the entire order of the image sequence. It is used to reverse
the generation of the depth map (see 14.8) - it switches „back“ and „front“.
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13.3

Fusion Profiles

Use the Fusion Profiles to save parameter settings in Focus Stacking algorithms for
future application. Here you have the possibility to import or export one or more
Focus Fusion Profiles. The current algorithm settings can be saved as a new profile
which can then be given its own unique name. If you would like to delete an active
profile from the database, click on the trash symbol.

13.4

Focus-Boost

Utilizing an internal computation process, recently developed Focs Boost technology
creates different image variations using your entered parameter settings and uses
these edited images to generate an even sharper Focus Stacking image.
Focus Squared Technology: generates different processed images that
are invisible to you from parameter settings in the vicinity of the actually
set values. These internal processed images are then joined to create the
final image using a special sharpness fusion method.
Focus Cubed Technology: is an enhancement of the focus squared
technology. It includes further parameter combination in the additional
stacking method. This calculation requires additional working memory
and a significantly longer calculation time.
Focus Infinity Technology: is the highest level of additional parameter
combinations for the additional stacking method. This calculation
requires additional working memory and a significantly longer calculation
time.
Diamond Cut: the diamond cut sharpness method was specially created
for focus stacking and reveals details more clearly.
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13.5

Focus Stacking Algorithms

FOCUS projects 4 offers 11 focus stacking calculation methods (algorithms) in total.
The algorithms highlighted gray are intended for use with low resolution images. The
remaing calculation methods are best suited for use when working with high
resolution images.
The algorithm “average” creates the simple average of your image sequence and lets
you compare image sharpness without determining the sharpness per pixel.
The following two algorithms (MSE and MCE) are stacking methods, which calculate
the weighting for the image areas (in mathematics, this means an nth order error
metric of the moment) from the sharpness per pixel.
The pyramid methods are complex methods that use, in addition, a so-called
Gaussian pyramid for every created image and then apply the sharpness method.
Colour (RGB) produces the image from the image sequence in accordance with the
colour strength.
The focus stack distance (variance) algorithm produces the image from the image
sequence in accordance with the brightness strength.
The four algorithms below are direct methods that let you determine image
sharpness from the difference, colour brightness and statistical variance.
Don’t get hung up on the technical terminology. Just go ahead and try the different
algorithms by clicking on them, and decide which one best suits your image.
Below the algorithms you have the parameter area for every selected algorithm.
Radius: The calculation width or accuracy of the process.
Smoothing: The strength of soft focus for the calculated weights.
Contrast border: The minimal sharpness necessary to declare a pixel as “sharp”. This
parameter helps to reduce image noise for the stacking calculation (see also chapter
14.7).
Halo balancing: This value determines whether the search will focus on fine details
(small value) or big details (large value). By adjusting this part of the calculation, you
can avoid stacking halos.
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13.6

Subject Brillance

Activate an intelligent degree of variation in tonal value by clicking the checkbox.

13.7

Depth Map

The Depth Map is a reconstruction of the distance
of individual pixels to the camera which provides
you with a 3D model of the surface of the object in
your photograph. This can be used to
retrospectively adjust the focal length to your
image in Post-Processing or to save a VRML model
for 3D printing.
The depth map can be found in the upper toolbar
above the image. This displays an additional area
where you can revert the depth map (if the images
are present “from back to front”). In addition, you
can set individual smoothing for the depth map
and save it as an image file.
The contrast border in the algorithm parameters
helps you to clear the depth map from areas that
were not properly recognised. This usually
happens if certain sharpness layers are not
displayed in the focus stack.
Increase the contrast border (in our example, to
50%) to automatically assign those areas with a
low contrast to the back area of the image.
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Here you can see the depth map of a camera with the lens superimposed

13.8

Contrast range

A calculation example:
The brightest area of an image has a value of 5
(the value 1 would mean a white pixel in the
image) and the darkest area in the HDR image
has a value of 0.01.
If one divides now 5 by 0.01 then the resulting
contrast rage of 5/0.01 = 500. This means that
the proportion between the brightest to the
darkest area of the image is 500 to 1.
From this contrast range you can take
inspiration from the area “contrast range”.
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The compression value shows how strong the compression of the HDR image
brightness is in comparison to a non-manipulated macro image. Here it is 0%, since
we haven’t done any changes yet.
The compression value you can adjust as you wish to. A low value creates a higher
contrast range in the macro image (the macro is being “stretched” in its brightness).
A higher value creates a smaller contrast range (the macro is being “compressed” in
its brightness).
Underneath the controller you will find three buttons, which control the automatic
optimisation of the contrast range:
 High-contrast: Creates a high-contrast macro image. Therefore an image with
very deep shadows and very bright lights.
 Optimal: Creates a well-balanced macro image.
 Compressed: Creates a macro image with a small contrast range. This can be
helpful with contrast rich bracketing series, since it helps to bring out further
details in tone mapping.
As soon as you confirm the automatic modus you will be able to follow live, how the
best values for your current HDR image is searched for.
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Tip:
This value is for every focus stacking algorithm different. So it could be a good idea
after the change of an algorithm to click on the desired automatic.
Under the automatic optimisation buttons you will find a curve display. This shows
how much the brightness values of the macro image have been adapted in the
contrast range optimisation of the program.
Curve display of the distribution of the brightness value:

High-contrast

Optimal

Compressed

High-contrast
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Optimal

Compressed
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14.

Lokal Adjustments / Selective Drawing

The selective drawing tool from FOCUS projects 4 deserves very special attention.
Firstly, this tool selectively edits chosen areas without complicated masks done by
hand, like other photo editing programs. FOCUS projects 4 includes a completely
newly developed intelligent border recognition algorithm that independently
identifies borders, lines, differentiations and light differences in drawing mode. The
boundaries of the area that the mouse skimmed
over are saved as a mask. These easily and
precisely set masks serve as the basis for 9
important image enhancements: “Shading",
“Illuminating”, “Intensifying Colour”, “Reduce
Colour”, “Strengthen Details”, “Reduce Details”
and “Sharpen”, etc. …
These masks can even be saved as its own image file and used in other photo editing
programs.
How it all works is probably easiest to explain with an example. Open the selective
drawing window (post-processing, finalise - bottom right). Our example is a single
image file of a gecko. The picture’s colour details are already well edited.
Now we want to slightly darken the wood without changing the rest of the image
(gecko and background).
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 Quickly finalize your image with Selective Painting
1. Select editing objective
For this case, select “Shading”. Make sure that the selected mask function is activated
and the green checkmark is showing.

2. Activate drawing mode
3. Activate filling mode
4. Run the mouse over the contours without clicking. You can decide and correct
the brush size afterwards.
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5. Now look at the mask display. The object where the borders were
automatically recognised is now depicted. Click and hold, and then trace your
mouse along the edges of your chosen object until it is completely selected. In
the blink of an eye we will see the effect as well as the overlying mask.

6. Once fully selected, blend the mask out by moving the mask intensity control
to the left.

7. You will now see only the effect that is darker wood – our objective was
„shading“. Now you can adjust the intensity of the effect by sliding the control
towards the + or -, according to your preferred strength. Done: The wood is
darker while the gecko and background remain untouched by the editing.
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8. Click on “Close”. You will be returned to post-processing and the selective
change will be applied.
9. Use your quickly made mask for a further effect. Go back to the selective
drawing. Our selective mask has remained.
10. Click on and copy the mask to the clipboard. Switch the mask to “Sharpen”
and use the
to paste the mask back again. Now you have sharpened just
the wood, and the other parts of the image were not influenced

11. Every selectively applied effect can be activated and deactivated with the
green checkmarks.

12. Borders have different intensities in every image. Presets normally do just fine,
but sometimes it is necessary to adjust the contour and sharpness settings in
order to reach perfect fine-tuned results.
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13. Have you drawn outside of the lines, despite the border recognition? You can
easily remove it with the eraser.
If you only want to remove a small
section, use the eraser with limitation. When set to 50%, you can only remove
50% of the mask, regardless of how much you erase. The limited drawing
mode works in the same way, and only draws at a certain opacity.
14. If you want to mask the entire image except for a small object, it is a good idea
to mask only the small object and then reverse the mask by clicking on the
Pro Tip: You have two filling modes to choose from when you want to fill a mask.
When do you use which mask? We used the normal fill mode
as in our example
for a large surface, which is also preferred for water and sky areas.
Ray filling mode
is very precise and favoured for smaller objects, geometric
forms or subjects with straight lines, like in our example here.

With ray filling mode you can mask just the walls of the skyscraper while the
window surfaces are not selected.
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Functions and Possibilities in Selective Painting
-

Optional mask colours

Choose for the presentation of the mask as well as the brush one of the ready-made
colours.

The display will be immediately adjusted to your desired colour.
-

Selective Drawing – Creating Masks

Masks can also be created from a colour or brightness.

With the button (1) you activate the “Create Mask” modus. You will find yourself in
the standard mode “Create Mask out of Colour”(2). If you want to create the mask
out of a brightness, chose the (3) button.
The tolerance controller decides, how sharp (smaller value) or soft (higher value) the
created mask will be.
While you are in the “create mask” mode your mouse pointer will turn into a pipette.
The colour or brightness in which your mouse pointer is set, will determine the type
of mask being created.
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In the above example we can see how a red mask has been created for the sky.
Tip: If you want to combine several colours in one mask, simply click on the desired
colours after each other with the pipette on the screen. The current colour will with
every click be added to the current mask.
-

Selective Drawing – Smoothing Brush

The smoothing brush (1) gives you the opportunity to draw selective areas of the
mask softly.

To draw an area even softer, just go over the same area with the smoothing brush
several times.
-

Global Mask Functions

In the area of global mask functions are several special modes that one can use
directly.
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1. Reducing the entire mask outline

becomes
2. Increasing the entire mask outline

becomes
3. Soft-focus on the entire mask

becomes
With global functions there are two buttons – the left button fulfils the function with
a lower effect while the one on the right with a bigger effect.
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-

To reset the function of a mask

Every mask can without any influence on the other masks be reset to its original
state. You simply click on the waste paper button (1).

After clicking on the button a security query will follow, so that no im-portant work
can be lost by accident.
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15.

Composing Mode

In the Composing mode of selective drawing you have
the opportunity to build up to four levels of images
into your current motif.
To switch into the composing modus, click on the
“composing” button (1).
From the list of choices (2) you can choose with which
composing level you want to work with.
With the button (3) you activate the currently chosen
mask. Now you can through a click on the frame of the
image (4) upload any image you wish to create the
next level.
You can use RAW images, Jpg, Tiff as well as several
other image formats.
Underneath the display screen you will find the
parameter area that begins with two buttons with the
following functions:
(5) Multiple Application
Reduce the size of the image on a different level than
the one that you´re currently working on. With this
option you will be able to stretch the reduced image outwards (up, down, left, right).
(6) Determine the Width-to-Height Ratio
This function allows you to determine the width-to-height ratio of the uploaded
levels, since the width-to-height ratio in an uploaded image level can differentiate
from the current image you´re working on. This preserves the proportion of the
levels.
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(7) Horizontal Reflection
This function allows the image layer to be mirrored horizontally. This enables more
precise adjustment to the current image without having to make changes to the
image layer.
(8) Vertical Reflection
This function allows the image layer to be mirrored vertically. This enables more
precise adjustment to the current image without having to make changes to the
image layer.
(9) The Control-parameter
Width-to-height ratio: If the width-to-height ratio isn´t fixed with the button (6), you
will be able to change the width-to-height ratio however you desire.
Zoom: Choose the size of that image level by zooming in or out
Shifting horizontally: Move the image level to the left or right
Shifting vertically: Move the image of that level up or down.
Exposure to light: Regularly the light from your current image does not match with
the exposure of your other image levels. Here you can adapt the exposure and
darken or brighten the images however you want, so that they match.

A night image with a not very fascinating night sky...
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....you can change within a minute with the help of composing into an eyecatcher.
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16.
Removal of Scratch and
Sensor Errors
Micro-contrast enhancement used in macro photography unfortunately shows every
unwanted sensor imperfection that every photographer, despite internal camera
sensor cleaning, knows and dreads. Don’t stress - just eliminate them! With the easy
to apply correction function from FOCUS projects 4, it can even be fun.
Pro Tip: This intelligent correction doesn’t only remove sensor spots, but other
disturbing things too - a deserted beach has never been so easy to produce.
Simply mark defects in your motif, the program will automatically substitute these
areas with other appropriate parts of the image.

The sensor spots are circled in red
Here’s how to go about correcting:
Select the brush tool under (6) and click on the point of the image that you would like
to correct. A circle will appear beside it that will serve as a source.
Move this circle to a place on the image that can act as a source for the first marking.
The selected area will then be improved based on the source.
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Prior to this, you can reveal sensor spots,
which will appear as a bright patch in the
image, with (1).
(2) Allows you to expose or hide the fixed
areas. The corrections are still active, even if
they have been blended in. Hiding is solely to
enable a before and after comparison.
You can select multiple areas to correct by
simply clicking on the brush symbol (6) and
adding another point.
The button marked (3) can blend the targeted
corrections in and out, which also controls
clarity.
(5) Deletes the added corrections.
The section marked (7) controls the size of the area that is to be corrected.
You also have the option to automatically search for the best source area for the
improvement. Click on the (8) button.
Button (4) calculates the appropriate correction spots for all of the points
automatically set using (8).
All currently selected corrections can be deleted with the (9) button.
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The sensor spot corrector marks all of the patches and determines a source within
the image that can be used as a substitute.

Successful sensor spot correction.
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17.

Workflow

 Edit final image further in an external program
FOCUS projects 4 offers interaction with external programs. That way you can take a
successful HDR result to another photo editing program and continue there.
 Open in other projects programs
Click on the “Projects” symbol in the toolbar to open the image in a different program
from the projects series. Use the drop-down menu beside the symbol to choose one
of the programs that you already have installed on your computer.

 Open in other photo-editing programs
To directly open the image in another photo editing program, such as Adobe
Photoshop, click on the corresponding button in the symbol bar.
If necessary, go through the settings to show the path to the program.
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Click on “Extras” in the menu and select “Settings” in the drop-down menu:

Next, click on the “Export” tab. You can enter the name of a photo editing program
here, and save it for later as well.

 Work with a timeline and restore points
This option can be found in the symbol bar at the top edge of the screen:

“Create Restore Point” saves an in-between point of the current set-tings. You can
now always return to this stage of your editing. You can save as many editing restore
points as you like. The timeline displays the restore points and makes it possible to
call up any phase with just a single click:
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This function is especially useful when, for example, you are satisfied with an image,
yet want to continue trying out different settings and effects. Simply set a restore
point and carry on editing your picture. If you want to go back, simply click on your
restore point

in the timeline. If you click on
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18.

Selecting and Saving Sections of Images

To save a final image, click on the button in the toolbar, go through the file menu or
use the corresponding keyboard shortcut (Ctrl+S).
 Cropping and captions
As soon as you have initiated to save a file, the cropping and caption window will
open. If you would not like to crop or add a caption to your image, click on continue.

At the top are several practical aids for perfect image composition and cropping.
You can set the aspect ratio and activate guidelines like the rule of thirds, the golden
section or the golden spiral. Practical is also the new photo centre display that you
can obtain by simply clicking on this button.
The centre of the window shows your final image. Fix the area to be saved by
adjusting the corners and borders of the photo.
At the bottom is an option to enter a caption. You can determine the size, position
and background for the text.
The size of the text will be automatically coordinated to the final cropping.
You can either crop free-handedly or use one of the 71 provided formats.
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Please note: If you choose the cropping, e.g. 13 x 18, the final image will not be
saved as 13 x 18 cm, rather as a ratio of 13 to 18.
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19.

Keyboard Shortcuts

Overview of the integrated Keyboard shortcuts
In the main menu in the area of information you will find an overview of all available
keyboard shortcuts.

Click on this item to open the overwiew:

In the overview you will be able to scroll through the different areas, where you can
take shortcuts.
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General:
Windows

Apple

Ctrl N

cmd N

New Project

Ctrl O

cmd O

Load Exposure Bracketing/ Image Sequence

Ctrl S

cmd S

Save Image

Ctrl D

cmd D

Print Image

Ctrl C

cmd C

Insert Final Image Into Clipboard

Shift Z

Shift Z

Create Undo-Point

Ctrl T

cmd T

Open Timeline

Ctrl F4

cmd F4

Quit Program

F5

F5

Process Exposure Bracketing/ Image Sequence

F6

F6

Process Weights

F7

F7

Switch to Post Processing

Ctrl P

cmd P

Open Setting

@

Open Homepage

Shift F1

Shift F1

Open About Dialogue

Ctrl I

Ctrl I

Display Information

Ctrl E

cmd E

Display Exif Information

Ctrl H

cmd H

Display/ Hide Histogram

Ctrl F

cmd F

Display Full Image

Image Display Functions:
Windows

Apple

Ctrl +

cmd +

Zoom in

Ctrl -

cmd -

Zoom out

Ctrl 0

cmd 0

Adapt to Screen

Ctrl 1

cmd 1

100% View

L

L

Lock Radar Window

History Browser:
Windows

Apple

Page up

Page up

Previous Page

Page down

Page down

Next Page

Home

Home

To Start

End

End

To End

Cursor left

Cursor left

Previous Entry
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Cursor right

Cursor right

Next Entry

Variation Browser:
Windows

Apple

Ctrl +

cmd +

Zoom in

Ctrl -

cmd -

Zoom out

Cursor left

Cursor left

Move View to the Left

Cursor right

Cursor right

Move View to the Right

Cursor up

Cursor up

Move View Up

Cursor down

Cursor down

Move View Down

Ctrl 0

cmd 0

Display All

Space

Space

Move View around Centre

S

S

Select Entry

Del

Del

Delete Entry

X

X

Compress View

Home

Home

Reset View

Weight Painter:
Windows

Apple

1

1

Select Red for Drawing

2

2

Select Green for Drawing

3

3

Select Blue for Drawing

Ö

Ö

Increase Brush Size

#

#

Reduce Brush Size

Sensitive Selective Drawing:
Windows

Apple

Ctrl +

cmd +

Zoom in

Ctrl -

cmd -

Zoom out

Ctrl O

cmd O

100% View/ Switch Fitting

A

A

Activate Brush

Shift A

Shift A

Activate Limited Brush

S

S

Activate Erasing Brush

Shift S

Shift S

Activate Limited Erasing Brush

W

W

Activate Soft-focus Brush

E

E

Activate Mark Creation from the Image

D

D

Activate Filling Mode

F

F

Activate Filling Mode for the Brush
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R

R

Activate Ray Mode for the Brush

1

1

Reduce Brush Size

2

2

Increase Brush Size

3

3

Reduce Opacity

4

4

Increase Opacity

5

5

Softer Contour Recognition

6

6

Sharper Contour Recognition

7

7

Reduce Softness

8

8

Increase Softness

Ctrl Z

cmd Z

Previous Step

M, Shift M

M, Shift M

Mask Display on/off

Scratch & Sensor Error Correction:
Windows

Apple

Ctrl +

cmd +

Zoom in

Ctrl -

cmd -

Zoom out

Cursor left, Shift Cursor left, Ctrl

Move Active Correction Area to the Left

Cursor left
Cursor right, Shift Cursor right,

Move Active Correction Area to the Right

Ctrl Cursor right
Cursor up, Shift Cursor up, Ctrl

Move Active Correction Area Up

Cursor up
Cursor down, Shift Cursor down,

Move Active Correction Area Down

Ctrl Cursor down
Page up

Page up

Select Previous Correction Area

Page down

Page down

Select Next Correction Area

C

C

Activate all Correction Areas

N

N

Set New Correction Area

Del

Del

Delete Active Correction Area

+

+

Increase Active Correction Area

-

-

Reduce Aktive Correction Area

Selective Processing:
Windows

Apple

Cursor left, Shift Cursor left, Ctrl

Move Selective Area to the Left

Cursor left
Cursor right, Shift Cursor right,

Move Selective Area to the Right

Ctrl Cursor right
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Cursor up, Shift Cursor up, Ctrl

Move Selective Area Up

Cursor up
Cursor down, Shift Cursor down,

Move Selective Area Down

Ctrl Cursor down
Page up

Page up

Select Previous Selective Area

Page down

Page down

Select Next Selective Area

Del

Del

Delete Active Selective Area

1

1

Do Not Display Mask

2

2

Display Mask of the Active Selective Area

3

3

Display Mask of All Selective Areas

Picture Cropping:
Cursor left, Shift Cursor left, Ctrl

Move Cropping Area to the Left

Cursor left
Cursor right, Shift Cursor right,

Move Cropping Area to the Right

Ctrl Cursor right
Cursor up, Shift Cursor up, Ctrl

Move Cropping Area Upwards

Cursor up
Cursor down, Shift Cursor down,

Move Cropping Area Downwards

Ctrl Cursor down

FRANZIS Verlag GmbH

82

FOCUS projects 4 – user manual

20.

Integrated list of supported RAW formats

In the main menu in the area information you will find an integrated list of supporting
camera RAW-formats sorted by manufacturer.

If you chose this menu item a camera RAW-format window will open.

In the top area of the window you will find a selection of choices, with which you will
be able to filter the list for singular camera manufacturers. This way you will find your
camera faster.
To have constant access to the supporting camera RAW- formats via a separate
window, you can use the function „open in browser“(window bottom left), which will
show the list in a standard browser. You will also be able to print the supporting
RAW-formats from there.
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Hotline/Support
Contact the FRANZIS Customer Service Team for questions about installation,
problems or disruptions concerning this software product.
E-Mail: support@franzis.de
Telephone (Monday - Friday 12-18:00): +49 (0)180 30 02 644
(0,09 EUR per Minute from German Landines, mobile rates may vary)
Telefax: 0180 300 26 45 (0,09 EUR per Minute from German Landines, mobile
rates may vary)
Please bear in mind that your inquiries can only be handled by the FRANZIS Customer
Service Support Team. This is how we can continue to make lasting improvements in our
service quality while answering your questions quickly and professionally.
Customer Service quick and easy:
Have important information concerning your PC system and product ready:
 Product Name
 Product-ISBN-Number (These can be found on the back side of the product
packaging located above the bar code).
 Operating System of your PC
 Information about your PC’s Configuration
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